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Brand Usage
Guidelines

The purpose of this guide is to illustrate proper usage of
the Lancaster Chamber corporate brand in its various,
approved forms.

Adhering to brand guidelines is critical to any
organization, with proper usage and consistency
becoming even more important when outsourcing
services from a variety of suppliers, whether it's for
print, online applications, signage, ad specialties, etc. It
is recommended that when providing digital files to an
outside supplier, you also provide a copy of this brand
usage guidelines PDF.

Some of the guidelines covered include: brand colors,
proper and improper usage of logos, file types supplied
and designated fonts.
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The Lancaster Chamber is a network of businesses,
organizations, and people working together to elevate
our business community. Since 1872, we've created
and strengthened connections across our region,
acting as a resource for economic growth as we build
a thriving community for all.

Lancaster Chamber



Our Organization

Vision
A Thriving Community for All.

Mission
Create the environment, facilitate

partnerships, and lead on issues
that elevate business success.

Core Value

Serve. Connect. Solve. Lead.

Key Messaging

SERVE

« The Lancaster Chamber is the
“Voice” of the Lancaster County
business community.

CONNECT

* The Lancaster Chamber i; a
connector of people, businesses,
and communities.

SOLVE

* The Lancaster Chamber equips
businesses with tools and resources
to strengthen business success.

LEAD

* The Lancaster Chamber, together
with community partners, is a
cataIKst for change and innovation
that helps shape a community
where everyone thrives.




Corporate Brand
Formats

The Lancaster Chamber corporate logo was designed to
be used in two basic formats. A horizontal version and a
vertical version that can be used .

Beyond these two formats, the logos are also supplied
in Solid Black (preferred), Reverse to Solid White (preferred),
Reverse to White, Grayscale (black with screens) and R




Logo Variations

Logo options in color.

Lancaster Chamber
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Logo Variations

Logo options in solid black (preferred).

. Lancaster Chamber

Laﬁéééter
Chamber




Logo Variations

Logo options for reversing out of a color,
with solid white in the icon. (preferred)

:- Lancaster Chamber

Lancaster
Chamber




Logo Variations

Logo options in black & white (grayscale).

Lancaster
Chamber
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Logo Variations

Logo options for reversing out of a color,
with transparency in the icon.

Lancaster Chamber

Lancaster
Chamber




Brand Colors

The Lancaster Chamber corporate logo consists
of five PMS colors. The color breakdown below
also includes the 4C process, CMYK builds
along with the conversions to RGB & HEX.

PMS 363

PMS 542

PMS 283

PMS 7684

- Lancaster Chamber

PMS PMS 7684 PMS 363 PMS 368
CMYK C87% C 74% C 58%

. M 68% M 24% M 2%
Builds Y 10% Y 100% Y 100%

K 1% K 8% K 0%

RGB R 55 R 75 R 120

i G93 G139 G 188
Builds B 157 B 64 B 67
HEX #375d9d #4B8B40 #78BC43

PMS 542

C 50%
M 20%
Y 5%
K 0%

R125
G174
B 211

#6699c2

PMS 283

C39%
M 14%
Y 0%
K 0%

R 148
G192
B 233

#94COE9
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Complementary Color
Palette & Opacity

These colors will complement the cool blues and
greens of the corporate logo. The use of
brighter and more vibrant colors reflect the
attitude and energy that the corporate brand
and the Lancaster Chamber portrays to the
business community.

Below are the primary and secondary colors shown in 100%, 65% screen and
35% screen.

PMS 7651 PMS 7406
CMYK: 61% 97% 25% 21% CMYK: 1% 18% 94% 1%
RGB: 106 42 91 RGB: 241 196 0

HEX: #6A2A5B HEX: #F1C400 PMS 7684

PMS 363

100% 100% 100% 100%
OPACITY OPACITY OPACITY OPACITY
65% 65% 65% 65%
OPACITY OPACITY OPACITY OPACITY
35% 35% 35% 35%
OPACITY OPACITY OPACITY OPACITY
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Brand Integrity

Maintaining the integrity of the elements that make up
the Lancaster Chamber logo ensures that it remains
consistent wherever used, which is critical to building
brand awareness.

While not every scenario and application can be
anticipated, the Lancaster Chamber corporate brand
should always be used exactly as they were supplied.
The sizing, placement, colors, proportions and
positioning of the logo elements - icon, name and
tagline - should not be altered in any way.

Correct Usage

080e%- X

“%.:. Lancaster Chamber et
Lancaster
Chamber

Lancaster




Typography

Corporate Font

The Lancaster Chamber logo uses the font
family Titillium. This font should also be used for main
headers on all marketing materials (print or digital).

Secondary Font

The Open Sans font complements the brand, is easily accessible, comes in a variety
of weights and italics and is a web-safe font for online and email applications. Use
this font for subheaders, secondary headers, and body copy text.

Titillium Web is the primary font
used for Lancaster Chamber's Regu |ar
marketing deliverables. It is best /tC]/ICS

used for headlines and subheadlines
Bold

TItI”IUIT] WEb Semibold

AaBbCcDdEeFfGgHhIiJjJKKLIMMNNOoPpQgRrSsTtUuVVWwWXxYyZz

Open Sans is the secondary font
e, ! Regular

used for Lancaster Chamber’s
marketing deliverables. It pairs ;
a well with Titillium Web and to lta/lcs
be used for body copy text B
old

Open Sans Semibold

AaBbCcDdEeFfGgHhIiJjKkLIMMNNOoPpQQgRrSsTtUUuVVWwWXXYyZz

THIS IS A HEADER

THIS IS A SUBHEADER

Body Copy. unt velit volorpos es necae atiam nobita qui se
doluptibus. Ut est pa pliatur autaquiati net voluptatium
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Visual Clarity

For the sake of clarity and clean design, consideration
should be given in allowing enough visual space
around all sides of the logo when used among text,

images and other visual elements.

Sunt velit volorpos es necae atiam nobita qui se doluptibus.Ectati
doluptat. Ut est pa pliatur autaquiati net voluptatium sus mi,

sint exceste veliandis verrum dolut officip samusto ruptasperum
sequidebissi od quos a conet atur alitionecta iscitio od quatiis

andant
dolestio.
lor Ximusto
ipsam anim
eostiosant
harchilliqui
comnihitiur

. Lancaster Chamber

ariasperat magnat.ltat apeditatem nihicil essit modi dolum
qui totas avoluptam, sum reritat aut est, conedj cds quuntib
vendiscdcn impeliquia eumijdoem faceremaqe explacienis.

Sunt velit volorpos es necae atiam nobita qui se
doluptibus.Ectati doluptat. Ut est pa pliatur autaquiati

net

sus mi, sint
verrum dolut o®
ruptasperum .‘..
quos a conet (X )
iscitio od
dolestio.
ipsam
harchilliqui
ariasperat
apeditatem
dolum qui

Lancaster
Chamber

voluptatium
exceste veliandis
officip samusto
sequidebissi od
atur alitionecta
quatiis andant
lor Ximusto
anim eostiosant
comnihitiur
magnat.Itat
nihicil essit modi
totas avoluptam,

sum reritat aut est, conedj cds quuntib vendiscdcn
impeliquia eumijdoem faceremqge explacienis unt.
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File Formats

The Lancaster Chamber logos are available in a
variety of file types. Following are their intended
uses:

EPS / Al

EPS / Al (vector) files are the recommended
file types to use for all printing applications
including literature, trade shows, signage, ad
specialties, etc. Vector files, created using
Adobe lllustrator, have the ability to enlarge to
extreme sizes without any loss in sharpness.

JPEG

4C (CMYK) and 1C (grayscale) logos are
available as jpeg files. These are 300 ppi - high
resolution files - that can be used for printing,
provided they're not enlarged more than 100%
of their actual size. RGB jpeg (72 ppi) files are
also available for digital applications.

PNG

RGB PNG files have a transparent background
and are available for email, online and other
digital application uses such as Word and
PowerPoint programs.
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isual Language

Gradient Mapping in Adobe Photoshop

Gradient Maps are an effective way to cover an image with a color filter while retaining control over the depth of the photo
from its shadows to highlights. Use a gradient map whenever there is a desire to add a color filter overtop of a phote.

The Gradient Map feature can be found in the Layers Panel under effects.

¢ Acceptable blending modes: Normal & Soft Light
¢« Background Graphics: (example below) Full Image, no burst, with less contrast so that copy can read on top.

+ Dimensional Graphics: Cutouts of imagery with implementation of burst graphics. Function as standalone graphics.

Color Values of the Chamber's Gradient Maps:

BACKGROUNDS
Blue
Light Blue
Green

Purple

DIMENSIONALS
Blue
Light Blue

Green

Purple

SHADOW RGE / CMYK

MIDTONE RGB /CMYK

HIGHLIGHT RGB /7 CMYK

55,93, 157 | 87,68, 10,1 o Midtone Value: 210,231,250 | 16,3,0,0
125,174,211 | 50,20, 5,0 T 240, 245,250 | 4,1,1,0
75,139,64 | 74,24,100,8 | function asthe highlights 222,242,206 | 13,0,24,0
106,42,91 | 61,97, 25, 21 for a background graphic 255,191,240 | 2,29,0,0
SHADOW RGE/ CMYK MIDTOME RGB / CMYK HIGHLIGHT RGB/ CMYK
55,93, 157 | 87.68.10,1 | 210,231,250 | 16,3,0,0 255, 255, 255 | 0,0, 0,0
125,174,211 | 50,20, 5,0 240,245,250 | 4,1,1,0 255, 255, 255 | 0,0, 0,0
75,139,64 | 74,24,100,8 | 222,242,206 | 13,0,240 | 255,255,255 | 0,0,0,0
106,42,91 | 61,97, 25,21 | 255,191,240 | 2.29,0,0 255, 255, 255 | 0,0, 0,0

Important Tips for Gradient Map Implementation:

1. Adjust gradient map color sliders to compensate

for background simplicity as well s for subtle light

on people and objects.

2. Convert burst graphics to smart objects before
relinking to a different colored burst in Lancaster
Chamber CC asset library. Doing this will prevent
the other CC linked files in the document from
switching as well. Also note that the color of the
burst does not need to be swapped if the gradient
map is applied to it for the correct hue.

3. Ifyouwould like to preserve some natural colors
from the photo, use the soft light blending mode cn
the pheto only, not the burst graphics. Burst graphics
should always be a LC Color.

4. Use no more than one “full burst” graphic in a
composition; place this one behind the focal point
in the photo to draw more visual emphasis.

The simpler burst graphics help by adding details
around the Dimensional without taking away from
the focal point.
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isual Language

Waves in Adobe lllustrator

Abstract waves are used to help add movement to a design, or to separate elements with a nice touch of color and depth.
Use a wave graphic to add more to the composition when the design feels like it needs a main visual component. Waves Can
be used to lead the eye to the focal point as well as separate elements on the page, such as photography and copy.

+ Colors: Gradients of the Chamber's Colored tonal range. Blue to Light Blue, Green to Light Green, etc.
+ Composed of: Two lines, merged hy smooth color blending features in lllustrator. File Examples:

Wave1 Blue

Waves4 Green

Wave5_Purple

To create waves: in Adobe Illlustrator Procedures:

1. Create two vector curved lines of your choice on your artboard. e Newly created wave files must be
approved by the Chamber Pricr to

2. Color each with a 2pt stroke thickness their use.

s Waves must startand finish in
a horizontal format.
s Only use one wave per design.

With both lines selected, go to Object > Blend > Blend Options;
choose smooth color

4. Then select Object > Blend > Make

5. The gradient transition between lines will now follow whatever
space is in between the lines.

Color Values of the Chamber's Waves:

Blue 55, 93, 157 87,68, 10,1 120,173, 211 16,3,0,0
Green 75,139, 64 74, 24, 100, 8 121, 188, 67 57.2,100,0
Purple 106, 42, 91 61, 97, 25, 21 217,141,199 | 13,53,0,0
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Visual Language

Wave Implementation Example

REPRESENTING BUSINESS 9 ¢ SERVING BUSINESS

At the Chamber, we have a mission to We know how important it is to grow your
consistently cultivate a thriving Lancaster skills and the skills of your team. The
County by being at the forefront of Chamber’s professional development
initiatives at a local, statewide, and calendar includes several delivery methods,
national level that move the needle on such as online courses, academics, and
issues that matter most to you. manthly programs.

CONNECTING BUSINESS ELEVATING BUSINESS

Whether you are a new business looking to 'g The Lancaster Chamber offers a variety

grow your network or you are an established of unigue optians for you to showcase

business seeking more connections, our your brand in front of curated business-to

networking events are valuable, intentional business audiences that will generate leads,

spaces to convene, connect, and grow, build brand awareness and strengthen
your prescence in Lancaster County.

Here's a call to action so people go to the website: lancasterchamber.com

Lancaster Chamber emailname@emaillocation.com ¢ 555.555.5555




Visual Language

Halftone Backgrounds in Adobe lllustrator

Lancaster Chamber uses halftone styling to unite a phote with a background that is white or colored. Halftones add an
element of energy, texture and movement. Halftones can be used to create a bold transition from a photo

Colors: LC Blue, LC Light Blue, LC Purple, Light Grays (=90% brightness) and Photo Masking
Application: Colored background or Photo layer mask = see page 4 for an exampie
Foreground use: LC Burst Only

Background use: Full page width halftone backgrounds. File Examples:

Adding the Halftone Effect to photography

1.

Adding a fill color to a halftone file {(no photo)

With halftone layer selected: Layer > Layer Style > Color Overlay

HALFTONE COLOR

Place your photo of choice in a layer directly over top of the
halftone layer

Hold Down ALT : Y @aTHoLD®

Hover over the two layers, and you will see an arrow v | Opaciy: | 100% | v
indication peinting to the layer below

Click while holding ALT

The image should now only be visible within the contents
of the halftone layer below it.

INITIAL COLOR RGB / CMYK
Blue 55,93, 157 87,68, 10,1
Green 75,139, 64 74, 24,100, 8
Purple 106, 42, 91 61, 97, 25, 21
Light Blue 125, 174, 211 50, 20,5, 0
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Visual Language

Halftone Background Implementation Example

REPRESENTING BUSINESS a0 SERVING BUSINESS

At the Chamber, we have a mission to (W\ﬂ We know how imoortant it is to grow your
consistently cultivate a thriving Lancaster 11l skills and the skills of your team. The
County by being at the forefront of Chamber’s professional development
initiatives at a local, statewide, and calendar includes several delivery methods,
national level that move the needle on such as online courses, acedemies, and
issues that matter most to you. manthly programs.

CONNECTING BUSINESS vy ELEVATING BUSINESS

Whether you are a new business looking to 8%@ The Lancaster Chamber offers a variety

grow your network or you are an established of unigue options for you to showcase

business seeking more connections, our your brand in front of curated business to

networking events are valuable, intentional husiness audiences that will generate leads,

spaces to convene, connect, and grow. build brand awareness and strengthen
your prescence in Lancaster County.

Here's a call to action so people go to the website: lancasterchamber.com

Lancaster Chamber emailname@emaillocation.com * 555.555.5555
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